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Introduction

The Renesas Solution Kit QE for BLE V1.0.0 (technical preview edition) is among the QE (Quick and Effective Tool
Solution) development assistance products for various applications. QE for BLE makes it easy to test the
communications features of the RL78/G1D (Bluetooth® low energy MCU), thus reducing development periods up to
the point where a product reaches the market.

This document describes the usage of this tool with examples. Refer to the help system of QE for BLE and the related
documents for detailed information on individual functions. Note that “QE for Bluetooth Smart” may be mentioned in
some places. This is the former product name, and should be read as “QE for BLE”.

Target Device
RL78 Family: RL78/G1D
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1. Configuration of a System

The configuration of a system where QE for BLE is in use is shown below.

e2 studio & QE for BLE GUI tool \

et Fartem Wb

Com Port Bcrate Sowion

-4

Bluetooth® device

Bluetooth® low energy
protocol stack

Figure 1-1 Configuration of a System

Operating Environment

e Host OS
Windows 7, 8.1, 10 (Japanese or English, 32-/64-bit)

e Environment for execution
V4.1.0 or a later version of the e? studio integrated development environment
V1.0.0 of QE for BLE (development assistance tool for Bluetooth® low energy)
V1.10 or a later version of the Bluetooth® low energy protocol stack GUI tool

e Library
Bluetooth® low energy protocol stack VV1.11

o Applicable board
RL78/G1D evaluation board

o Others (Bluetooth® devices for checking operation at the other party)
Smartphones or tablets which support V4.0 or a later version of the Bluetooth specification

Note: V3 of the RFP (Renesas Flash Programmer) flash programming tool and E1 emulator are needed separately if
the RL78/G1D evaluation board is to be programmed.
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Figure 1-2 Configuration of Software

The Bluetooth® low energy protocol stack GUI tool controls the Bluetooth® low energy protocol stack on the
RL78/G1D evaluation board through a modem configuration, manually from a PC. That is, this tool transmits or
receives rBLE commands and events by serial communications.

QE for BLE is plug-in software for the e? studio IDE. This software provides assistance in creating and executing rBLE
script files. By executing rBLE scripts, the Bluetooth® low energy protocol stack can be controlled automatically
through the GUI.

You can try the script function of issuing APl commands to the Bluetooth® low energy protocol stack, and immediately
check the state of the responses in a log of communications. Hence, you can concentrate on learning the basic functions
of communications via Bluetooth®, without having the need to create complicated embedded programs involving work
such as making the initial settings of the MCU.
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2. Advance Preparation

2.1 Downloading
This section describes how to obtain the software required to use the QE for BLE.

Table 2-1 List of the Required Software and URLs of the Download Pages

Software URL

e? studio https://www.renesas.com/e2studio

QE for BLE https://www.renesas.com/qe-ble

Bluetooth® low energy protocol stack https://www.renesas.com/solutions/key-
technology/connectivity/bluetooth-smart/protocol-
stack.html

Bluetooth® low energy protocol stack GUI tool https://www.renesas.com/solutions/bluetooth

Microsoft Visual C++ Redistributable https://www.microsoft.com/en-
us/download/details.aspx?id=30679

Related documents https://www.renesas.com/products/microcontrollers-

microprocessors/rl78/rl7891x/rI78gld.html

2.1.1 Downloading the e? studio
Access the below URL from your Internet browser and download the installer for the e? studio.

o Download page: https://www.renesas.com/e2studio

Note: You also need to download and install a compiler (such as the CC-RL C compiler package for the RL78 Family)
when you build programs in the e? studio, since they are separate products. You can download them from the
above URL.

2.1.2 Downloading the QE for BLE
Access the below URL from your Internet browser and download the QE for Bluetooth Smart VV1.0.0 (technical preview
edition; filename: RenesasQE_ble_V100.zip).

If you already have the e? studio, select this document from the Smart Browser of the e? studio, and download [Sample
code (Download)] from the menu displayed by right-clicking on the window.

o Download page: https://www.renesas.com/ge-ble

2.1.3 Downloading the Bluetooth® low energy protocol stack

Access the following URL from your internet browser, and download “Bluetooth® low energy protocol stack” (file
name: RTM5F11A00NBLEOF10RZ-V0120.zip).

o Download page: https://www.renesas.com/solutions/key-technology/connectivity/bluetooth-smart/protocol-
stack.html

214 Downloading the GUI tool

Access the following URL from your internet browser, and download “Bluetooth® low energy protocol stack GUI tool”
(file name: an-r01an2469ej0112-g1dguitool-apl.zip).
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e Download page: https://www.renesas.com/solutions/bluetooth

The GUI tool is a C++ application built by using Microsoft Visual Studio 2012. To execute the GUI tool, you need to
obtain Visual C++ Redistributable and install the runtime components.

215 Downloading Visual C++ Redistributable

Access the following URL from your internet browser, and download “Visual C++ Redistributable for Visual Studio
2012, Update 4”.

e Download page: https://www.microsoft.com/en-us/download/details.aspx?id=30679

Note: The GUI tool is a 32-bit application. Download Visual C++ Redistributable (VSU4\vcredist x86.exe) for 32-bit
versions (x86) even if you are using a 64-bit version of Windows.

2.1.6 Obtaining related documents

The following is a list of documents that will be helpful when you use QE for BLE. Access to the below URL from
your internet browser and download them.

Table 2-2 Related Documents

Document name Document number
Bluetooth® Low Energy Protocol Stack RO1UWO0095
User's Manual

Bluetooth® Low Energy Protocol Stack RO1AN2767
Quick Start Guide

Bluetooth® Low Energy Protocol Stack RO1AN1375
Sample Program Application Note

Bluetooth® Low Energy Protocol Stack RO1AN1376
rBLE Command Specification

Bluetooth® Low Energy Protocol Stack RO1AN2469
GUI tool

QE for Bluetooth Smart RO1AN3154
Sample Script for the RenesasBLE

Bluetooth® Low Energy Protocol Stack RO1AN3015
RenesasBLE (for Android) Application

Bluetooth® Low Energy Protocol Stack RO1AN3016

RenesasBLE (for iOS) Application

e Download page: https://www.renesas.com/products/microcontrollers-microprocessors/rl78/rl78g1x/rl78g1d.html
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2.2 Installing

This section describes how to install the software obtained by following the directions in the previous section.

2.2.1 Installing the e? studio
Execute the installer for the e? studio integrated development environment, and install it (the e? studio main unit and
individual components) by following the directions on the screen.

Checking on “Renesas Smart Help” on the selection screen of components for the e? studio during setup before
installation selects inclusion of the Smart Browser. This allows you to download documents (User’s Manuals and so on)
for Renesas products directly from the e? studio window.

e Refer to: https://www.renesas.com/su

BN & studio Setup O *
e studio 5.2.0.020 Setup
LENESAS
= Welcome Select the components you want to install and deselect the components you do not want to install.
o Install Falder @ Required Components £ "
. . e2 studio
# Device Families
Fa Optional Components #
#! Extra Components
Renesas RLT8 Debug Support
Components Hardware Debug Support for Renesas RL78 devices
Renesas CCRL Toolchain Integration
[1GCC for Renesas RL78 Toolchain Integration
Renesas Smart Help
Renesas Stack Analysis
Renesas Stack Analysis & Optimisation Assistant W
Select All Opticnal | | Deselect All Optional
Arcund 3801 ME required
v201609201032 < Back Mext > Install Cancel

Figure 2-1 e? studio Setup: Selection Screen of Components

222 Installing the QE for BLE
Install the QE for BLE with the following directions.
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Stepl

Step 2

Mavigate Search Project RenesasViews Run  Window Help

Welcome

(7) Help Contents
% Search
Dynamic Help

Key Assist...
Tips and Tricks...

Ctrl+Shift+L

R FRenesasRulz Commur  Select the [Install New Software] item from the [Help] menu

£ Add Renesas Toolchai

Cheat Sheets...

'Qhﬁewwwtﬂ-----------
| % Install New Software...

of the e? studio.

)

Renesas e2 studio feedback

i [|AR Embedded Workbench plugin manager...

About e2 studio

IE‘ Install

Available Software

Select a site or enter the location of a site.

P

Work with: | type or select a site

Add...

type filter text

Name

[0 @ There is no site selected.

Select All Deselect All

Find more software by working with the "Available Software \Eprﬁeng

Verion | Click on

Details

Show only the latest versions of available software
Group items by category
[[]Show only software applicable to target environment

[l Contact all update sites during install to find required software

[ Hide items that are already installed

What is already installed?

the [Add] button.

’_

@

< Back Next > Einish Cancel
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Step 3
Add Repository X
Marme: Local...
' [N | - \
I Location: | jarfile,/Ci/Users/app/Downloads/RenesasQE_ble V100.zip Archive... '
e 8 8 0 B _ N _ B _ B _ B _ B _ B _ B _ B _ B B _§B & _§B &+ B _&§B B |
Specify the downloaded ZIP file
: . ¢ containing QE for BLE.
Step 4
le? Install [m] X
Available Software
Check the items that you wish to install, \‘9:
Work with: | jarfile:/C:/Users/app/Downloads/RenesasCE ble \100.zip!/ V|| add..
Find more software by working with the "Avsilable Software Sites” preferences.
Check the boxes below
| Name y Version
L_ o R B B N N N 4
' v [ 000 Renesas QF
[+ Renesas QF common 1.00.201602011351
'l [ 4= Renesas QF for Bluetooth Smart , 1.0.0.201602251158
L B B B B BN N _§ |
Select All Deselect All 2 items selected
Details
Shaw anly the latest versions of available software [ Hide ftems that are already installed
[ Group items by category What is already installed?
[[]Show only software applicable to target environment
[l Contact all update sites during install to find required software
3 r _H N 4
? < Back Next > Finish Cancel
Click on the [Next>] button.
Continue through the procedures of the security warning message and
trust certificate, then restart the e? studio.
Figure 2-2 Installing QE for BLE (Outline)
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Installation (detailed description)

1. Start e studio V4.1.0 (or a later version).

2. From the [Help] menu, select [Install New Software...] to open the [Install] dialog box.

3. Click on the [Add...] button to open the [Add Repository] dialog box.

4. Click on the [Archive] button, select the zip file for installation in the opened dialog box, and click on the [Open]

button.

Click on the [OK] button in the [Add Repository] dialog box.

6. Select the [Renesas QE for Bluetooth Smart] check box displayed in the [Install] dialog box and click on the [Next]
button.

7. Check that [Renesas QE for Bluetooth Smart] is selected as the target of installation, and click on the [Next] button.

8. After confirming the license agreement, select the [I accept the terms of the license agreement] radio button, and
click on the [Finish] button.

9. A security warning message will appear; click on the [OK] button to continue installation.

10. If the dialog box for the trust certificate is displayed, check that certificate and click on the [OK] button to continue
installation.

11. When prompted to restart the e2 studio, restart it.

o

2.2.3 Installing the GUI tool

Decompress the package of the GUI tool and copy it to a folder of your choice. The configuration of files and folders
after installation is shown below. Compare your installation against this to see if any files are missing.

an-r0lan2469jj0112-gldguitool-apl
Frolan2469jj0112-gldguitool .pdf Application Note: GUI Tool

LrBLE_Tool Executable files
FrBLE_Tool .exe GUI tool executable program for Windows PCs
FrBLE_Tool . ini INI Ffile for the GUI tool
LrBLE_Tool _Err_Msg.tbl Definition file for error messages
224 Installation of Visual C++ Redistributable

Execute the installer you have downloaded for Visual C++ Redistributable for Visual Studio 2012, Update 4, by
following the directions on the screen.

Note: The GUI tool is a 32-hit application. Download Visual C++ Redistributable (VSU4\vcredist_x86.exe) for 32-bit
versions (x86) even if you are using a 64-bit version of Windows.
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3. Using the Tool

3.1 Connecting the RL78/G1D evaluation board

Connect the RL78/G1D evaluation board and your Windows PC with a USB cable. Write the Bluetooth® low energy
protocol stack (hereafter, it is referred to as BLE software in this section), which has a modem configuration, to the
RL78/G1D evaluation board in advance.

Connecting the RL78/G1D evaluation board to your PC may require a device driver for the FT232RL, which is a
UART-USB conversion IC. Obtain the driver from the site of Future Technology Devices International Ltd if you need
it.

e Download page: http://www.ftdichip.com/Drivers/D2XX.htm

Note: Download the x86 (32-bit) or x64 (64-bit) device driver depending on your version of Windows.

To check whether the RL78/G1D evaluation board is properly connected, display the Device Manager of your
Windows, and check that USB Serial Port (COM**) is displayed under [Ports (COM & LPT)]. Take a note of the port
number of “COM**” for that serial port. While it is shown as “COM3” in the following example, it will not always be
shown as COM3 on your PC since the number depends on the environment.

&= Device Manager _ 0 %
Eile Action View Help
e | @ E HmE | FRS

v = DESKTOR-SG9564A2 ”
I Audio inputs and outputs

@ Batteries

[ Computer
Disk drives

B Display adapters

- DVD/CD-ROM drives

i Floppy disk drives

=& Floppy drive controllers

':h“_-, Hurnan Interface Devices

L |DE ATA/ATAP| controllers

== Keyboards

ﬂ Mice and other pointing devices

1 Monitors

Iﬂ Metwork adapters

~ "2 Ports (COM & LPT)

‘? Communications Pert (COM1)
‘? Communications Pert (COM2)
‘? Printer Port (LPT1)
=" USB Serial Port (COM3)

= Print queues

D Processors

Il Software devices

%, Scund, video and game controllers

<, Storage contrellers
[T Suretern devires

Figure 3-1 Screen of Windows Device Manager
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3.2 Activating the tool

3.2.1 Launch the GUI tool

Activate “rBLE_Tool.exe” which is in the folder where the executable file is stored. The files listed below are essential
to run this GUI application. Thus, make sure all of these files are in the same folder.

Table 3-1 GUI Tool Files

File name Description

rBLE_Tool.exe GUI tool executable program for Windows PC
rBLE_Tool.ini INI file for the GUI tool
rBLE_Tool_Err_Msg.tbl Definition file for error messages

Note: If the INI file is not present, the GUI tool will automatically create it after you close the tool.

Once the GUI tool application is open, the [Serial port settings] dialog box window shown below pops up. Select the
appropriate serial com port that is connected with the RL78/G1D evaluation board and set the baud rate. Next, click on
the [OK] button to confirm the setting. The dialog box will then close. If you are using a UART 2-wire branch
connection, check the [UART 2-wire with Branch Connection] check box.

Serial port settings >

IrCl:llTl Port COM3 | |

------------J

Baud rate 4300 o]
Select the number which you noted in the prior section.

[ JUART 2-wire with Branch Connection

Cancel

Figure 3-2 Serial Port Setting

Note: Specify the correct baud rate in the GUI to match the BLE software baud rate. In the modem configuration, the
default baud rate is 4800 bps.

After making the correct baud rate and serial port settings, the GUI tool will initiate communications with the BLE
software that runs on the RL78/G1D. The GUI tool has two dialog boxes: the main [rBLE_Tool] pane and the [Log]
pane. They are shown below.
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rBLE_Tool [1] - x 0
GAP Peer Device Vendor Specific GATT  Profiles Save Clear
Standby [0] Tx —> Tue Nov 01 14:29:57.112

- RBLE_GAP_Reset
Generic  Advertising Scanning  Security White List

[1] Rx <— Tue Mov 01 14:29:57.256

RBLE_GAP_EVENT_RESET_RESULT
|rELEVEr;\Dn = 01.11(0K) | a0k -

Major Version = 01
Minor Version = 11

Set Name [1BLE Sample |
Get Device Info HCl Ver. | |
vever | |

Host Ver | |

Company | |

| |

BD Address

Own Address: (® Public () Randem

Set Random Address |000000000000

COoM3 4300 Hide Log < Ed

Figure 3-3 Main and Log Panes

3.2.2 Activating the e? studio

Select e? studio from the shortcut menu in the start menu of Windows, or activate “e2 studio.exe” which is in the folder
where it was installed (or under “C:\Renesas\e2_studio\eclipse” by default).

3.3 Creating a project
To create a project with the e? studio, open the wizard to do so by either of the following methods.

o Select the [C Project] menu item from [New] in the [File] menu in the menu bar at the top of the e? studio.
o Select the [C Project] menu item from [New] in the pop-up menu of the [Project Explorer] view.

Operate as follows in the displayed wizard dialog.
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Step 1

C Project

C Project
Create C project of selected type

AR N I .-

I Project name: | test

Uze default location
Location: | CA\Users\app'e2_studio\workspace\test

Create Directory for Project

‘--------------------------------l

Input a project name

w = Static Library (Renesas)
& Sample Project
» = Makefile project

Project type: Toolchains:
v = Executable (Renesas) | Renesas CCRL Toolchain i
® Sample Project = Ml AT R ToolcRam, = -

Select “Renesas CCRL Toolchain”

Show project types and toolchains only if they are supported on the platform

@ e ] e

Click on the [Next>] button

R20AN0429EJ0100 Rev.1.00
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Step 2

C Project

e2 studio - Project Generation

Select Target Specific Settings

Toolchain Version: | w1.03.00 w
Debug Hardware: | E1/E20 (RLTE) W
Select Target: R3F11AG) 1

‘------------------;I-

Select Configurations:

Hardware Debug i Debug using hardware
Debug using Simulator : Debug using simulator
[ ] Release (no debug) : Project without any debug

Build configurations will be created in the project only for
options, however by default the project will be built for th
first configuration selected from group. Based on the dev
- G1D) the debug hardware (E1/E20 (RLT2)) and debug tar

configuration will be autoratically created for you.

@ < Back Nea> | [

Select [RL78/G1D] and then R5F11AGJ from [Select Target],

then create the project by clicking on the [Finish] button.

RSF11AGG RL78- G1D 48pin >
RSF11AGH

R3F11AG)

6
&

RL72 - D1A
RL78 - F1A
RL78 - F12
RL78 - F13

RL7E - F14
RL78 - F15
RL7E8 - G1A
RL78 - G1C
RL78 - G1E
RL78 - G1G
RL72 - G1H
RL78 - G10
RL78 - G12
RL7& - G13
RL7S - G14
RL78 - NA
RL7S - 1B

RL7E - D

RL78 - L1C
RL78 - L12
RL78 - L13
RL78 - G1F
RL7& - NE

RL7E - G1D
RL78 - NC

RL78 - G11
RL78 - L1A

e

R

W

e

Figure 3-4 C Project Creation Wizard
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3.4 How to use rBLE script files

3.4.1 Creating a new file
To create a new rBLE script file, open the wizard through either of the following methods.

e Select the [Other] menu item from [New] in the [File] menu in the menu bar at the top of the e? studio.
o Select the [Other] menu item from [New] in the pop-up menu of the [Project Explorer] view.

Operate as follows in the displayed wizard dialog.

Step 1

? cock f| wews | g
I J

New O ¥
Select a wizard —
Create a new rBLE script file to use in "QE for Bluetooth Smart”. '
Wizards:
type filter text
= General
w [~ Renesas OF |
| ET rELE Script File (QE for Bluetooth Smart) I
Select “rBLE Script File”.
[ 1 5how All Wizards.
I S -
Cancel

Click on the [Next] button.
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Step 2

(E for Bluetooth Smart O w

rBLE Script File (QE for Bluetooth Smart)
Specify a file name for new rBLE script file,

Enter or select the parent folder:

| test

&
5 test

| File name: | testl
‘--------------------------------

Advanced » >
Input a file name.

?\ < Back MNext = I 1 Cancel
J

Create a file with clicking the [Finish] button. =

Figure 3-5 File Creation Wizard

Creating a new file (detailed description)

1. Select the [Other] menu item from [New] in the [File] menu of the e? studio, and open a [New] dialog.
2. Select [rBLE Script File (QE for Bluetooth Smart)] under [Renesas QE], and click on the [Next>] button.
3. After selecting the parent folder as the destination for the file, input the file name and click on the [Finish] button.
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3.4.2 Importing an existing file
You can import an existing rBLE script file to a project through either of the following methods.

e Dragging and dropping the file
e Using a wizard

Dragging and dropping the file

Drag the target file from Windows Explorer to the e? studio window, and drop it under the node which shows projects
in the [Project Explorer] view of the e? studio.

After the file is dropped, the [File Operation] dialog box is displayed. Select [Copy files].

File Operation >

N Select how files should be imported into the project:

l’ i Link to files

Create link locations relative to:  |PROJECT LOC

Configure Drag and Drop 5ettings...

@

Figure 3-6 [File Operation] Dialog Box after Dropping a File

Using the wizard

Open the wizard through either of the following methods.

e Select [Import] from the [File] menu of the main menu bar at the top of the e? studio.
o Select [Import] from the pop-up menu of the [Project Explorer] view.

Operate as follows in the displayed wizard dialog.
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Step 1

Import

Select

Import resources from the

local file systern into an existing project. | g - 5 I

Select an import source:

type filter text

v (= General
& Archive File

' [} File System
— i L ) -
] Preferences

Select [Flle System] S Rename & Import Existing C/C++ Project into Workspace
w Renesas CATEKOR Project

Step 2

= C/C++
= Install
(= Run/Debug
(= Team

(= st '-i'\l’orkspace

= Renesas Common Project File

- od

= Back MNext > I Finish Cancel

Click on [Next>] B

Import

File system

Import resources from the local file system. D

r--

‘--

From directory:

Ch\Users\app\Downloads\an_r01an3154jj0100_gessrble\sample_script  ~ Browse...
L i L L 1 1 1 1 I I T _ 1

[m] = sample_script

After specifying the folder which contains the target file,

check the box against the file to import.

E-CyclingSpeedAndCadenceSensor.rbIe -
[ TP Y O, TS o T, e O, PR J

Filter Types... Select All

Deselect All

Into folder: | test

Browse...

Options

[] Overwrite exi sting resources without warning

[] Create top-level folder

Advanced =>

Import the file by clicking on the [Finish] button.

--J

< Back Mext = m I Cancel

Figure 3-7 Import Wizard
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3.5 Using the rBLE script editor

3.5.1 Opening the editor window

To open the editor, double-click on an rBLE script file in the [Project Explorer] view. An rBLE script file has “.rble” as
the filename extension, and is displayed with the icon 5 in the [Project Explorer] view.

To check whether the editor which was opened by double-clicking on the filename is the rBLE script editor or not, refer

to the tabbed page of the editor. The description on the tab being «H filename (QE)” means that the rBLE script editor
has been opened. Since the e? studio’s general text editor may have been opened if this is not the case, try reopening the
target file through the following method.

1. Inthe [Project Explorer] view, select the rBLE script file which is the target.
2. Select the [rBLE script editor] menu item from [Open from the Application] from the pop-up menu.

The rBLE script editor provides functions which are optimized for editing rBLE script files. The following sections
describe those functions.

3.5.2 Highlighting

In the rBLE script editor, scripts are colored and highlighted by category depending on the input token (words and
phrases: the minimum unit is one word).

Table 3-2 List of the Highlighted Categories

Category Description

Default Letters are not highlighted.

#comment From # in single-byte character coding to the end of
the line.

Reserved word The word functions as a script instruction.

rBLE command The word is a command supported by the API of the
BLE protocol stack.

rBLE event The word indicates the notification of an event by the
BLE protocol stack.

“character string” A section enclosed by “ " in single-byte character
coding.

Refer to the help system that accompanies QE for BLE for rBLE script specifications such as a list of the reserved
words that can be entered in the rBLE script editor. To produce the help system, click on the [F1] key while the rBLE
script editor is active.
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3.5.3 Autocompletion

The rBLE script editor provides an autocomplete window, which lists predicted rBLE commands or events in
alphabetical order. Display the autocomplete window in the following way.

e Press [Ctrl] and [Space] in the editor.
e Input “rble” in the editor (not case-sensitive).

The predictions are displayed after filtering out the rBLE command or event names starting with the character string
that has already been in place up to the position of the cursor (the position to which the word has been inserted).

Table 3-3 Autocomplete Window: Type of Prediction

Icon Type of prediction
@ rBLE command
4 rBLE event

In the autocomplete window, use the up and down cursor keys to select a word from among the predictions, and select
one by pressing the [Enter] key. The rBLE command or event will then be added to the given line in the editor. You can
also narrow down the list of predictions by inputting letters as desired while the autocomplete window is being
displayed.
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BT *testl.rble (QF) 52

1 rble |

- % PRBLE_GAP_EVEMT_SET SECURITY_REQUEST COMP L]
Display the autocomplete window by entering “rble_”. FVENT WR_CHAR IND

: et _Device_Info

RELE_GAP_Get_Remote_Device_Info
RELE_GAP_Get_Remote_Device_Mame
RELE_GAP_Get White_List_Size
RELE_GAP_Observation_Dizable

|

RELE_GAP_C gelect a command or event with the cursor keys.
RELE_GAP_Rcuvseres -

RELE_GAP_Reszet
RELE_GAP_Set_Bonding_Meode W

ol =< R I T el

Input “gap_r” as a continuation from “rble_".

1 Ible_gap_rl

@ RELE_GAP_Read_RSSI
) RELE_GAP_Reset

%]

Input additional letters to narrow down

the range of predictions.

B *testl.rble (QF) 52 :
_ Select the required command or event type
- RBLE_GAP_Reset] by pressing the [Enter] key.

%]

Figure 3-8 Autocomplete Window

For the list of rBLE commands or event types and arguments, refer to section 6 “rBLE Commands” or 7 “rBLE Events”
in the Bluetooth® low energy Protocol Stack rBLE Command Specification (document no: RO1AN1376). Note that the
interpreter for rBLE commands and event types written in rBLE scripts is case-sensitive.
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3.54 Outline of the rBLE script specification

An rBLE script controls (in a modem configuration) the BLE software from Renesas that has been written to the
RL78/G1D evaluation board. Along with issuing rBLE commands and reception of rBLE events, scripts support the
four basic arithmetic operations and control over execution (recursion and conditional branching).

Refer to the help system that accompanies QE for BLE for details of the rBLE script specifications. To produce the help
system, press the [F1] key while the rBLE script editor is in scope. The issuing of rBLE commands and reception of
rBLE events are described below and on the next page.

Issuing rBLE commands

An rBLE command is issued (called) by a call instruction. For example, to reset the GAP (Generic Access Profile) enter
the RBLE_GAP_Reset rBLE command in the way shown below. Since nothing is specified as the data format for
RBLE_GAP_Reset in the rBLE Command Specification, the statement does not take any arguments.

call RBLE GAP_Reset

To issue an rBLE command, you need to write the rBLE command and arguments following a call instruction. Neither
can be omitted. For example, the rBLE command RBLE_GAP_Set Bonding_Mode is used to set a bonding mode. In
the data format of the rBLE Command Specification, since the mode is written in both octetO and octet1, it means there
is one 16-bit wide argument. Hence, this command will be entered in the following way in an rBLE script.

call RBLE GAP_Set Bonding Mode 0x0200

Reception of rBLE event notifications

An rBLE event notification is received (waited) by placing a wait instruction before the event type. For example, to
receive notification of the event of the GAP having been reset, use RBLE_GAP_EVENT_RESET_RESULT as an
rBLE event. Write waits for event notifications in rBLE scripts as follows.

wait RBLE_GAP_EVENT_RESET RESULT status, major, minor

# 1T you do not use the return values from the event.
wait RBLE_GAP_EVENT_RESET_RESULT

You need to write the wait instruction followed by the name of the rBLE event and the return value of the rBLE event.

If you do not use the return value or values of an rBLE event, you can omit the statement of the return values, as in the

example above. When both the name and return values of an rBLE are omitted, the type of rBLE event does not matter,
and this function causes the script to continue to wait until any rBLE event is received.

Note: Omitting only the name or only one or some return values of an rBLE event is not acceptable for a wait
instruction.

3.6 Running and stopping rBLE scripts

3.6.1 Running a script
Run an rBLE script through either of the following methods.
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e Click on the [Fi:*-:l'] button in the toolbar at the top of the e? studio.
e Select [Run rBLE script (QE)] from [Run] on the e? studio’s main menu.

Ci | B Q ﬁ:.i._’ Run
*% Debug
Ly Project Explorer 53 Ry
Run As

v [ test [HardwareDebu R T el

[t Includes

2 src

custom,bat

B CyclingSpeedAnd

Debug History
Debug As
Debug Configurations...

test Debug.launch Toggle Breakpoint

test HardwareDeb

é"t bl Teggle Line Breakpoint
est.rble

Toggle Method Breakpoint
Toggle Watchpoint

® Skip All Brezkpoints
Remove All Breakpoints

Breakpoint Types
G, External Teols

Y& Run rBLE script (QF)

C/C++ - test/CyclingSpeedAndCadenceSensarrble - e studio

File Edit Source Refactor MNavigate Search Project Renesas Views Run | Window Help

coeFln AR Qv Quvif® iG] (ML v Gl O

(avccsccer |

sedAndCadenceSensor.rble (QF) 57

| Reset
| GAP Reset
| GAP_EVENT RESET RESULT

F_Set_Security Regquest

| GAP Set Security Request SecMaode
GAP EVENT SET SECURITY REQUEST COMP
Ctrl+5hift+B
F_Set_Security Regquest

| GAP_Set Bonding Mode BondingMode
| GAP_EVENT SET BONDING MODE COMP
Ctrl+Alt+B P _Broadcast_Enable

06, Name="QE for BLE"™, Service=C5CS,DIS
| GAP Broadcast Enable DizcMode, ConMode,
| GAP_EVENT BROADCAST ENABLE COMP

LdviInt,

f connection cc:rr.p'_et,e
| GAP_EVENT CONNECTION COMP Status, null,

ConHdl,

CP_Sensor Enable
call RBLE CECF_Sensor Enable ConHdl, Seclvl,
wait RBLE CSCP EVENT SENSOR ENABLE COMP

ConTvpe,

R
£

& Console &2

Mo consoles to display at this time,

Writable Insert 178:1

C5C_MeasurementNtf,

LdvInt, AdvType

PeerhddrType, B

FEre g

Figure 3-9 Running an rBLE Script

Running an rBLE script does not require storage of the statements in the rBLE script editor in a file. Running an rBLE
script while it is being edited still processes the contents (the contents immediately before execution) of the editor. The

file is not saved at this time.

An RL78/G1D evaluation board to which the BLE software and Bluetooth® low energy protocol stack GUI tool have
been written is required for Bluetooth®-specification communications by this tool. You need to activate the GUI tool
(rBLE_Tool.exe) before executing an rBLE script.

3.6.2 Stopping a script

Stop the rBLE script with following method.

1. Click onthe ["-"L"] button near the right end of the status bar at the bottom of the e? studio window to open the

[Progress] view.

2. Click on the [] button across from the message “Running an rBLE script” in the [Progress] view.
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Step 1
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g v 1 ¥ test.
v (25 test [HardwareDebug] 2 call RBLE GAP Reset
[t Includes ‘- walt
B src =
custom.bat
B CyclingSpeedAndCadenceSensor.r
|Z| test Debug.launch
|Z| test HardwareDebug.launch
BT testl.uble
oble Tasks B Console 3
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Run from #2.
Launch the GUI-Tool (rBLE_Tool), before running an ri
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Figure 3-10 Stopping an rBLE Script
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3.6.3 Sample scripts and the RenesasBLE application
Sample scripts that are executable with the rBLE script function of this tool is available on the Renesas Web site.

Table 3-4 List of the Documents Related to Sample Script

Document name Document number
QE for Bluetooth Smart Sample Script for RO1AN3154
RenesasBLE

Bluetooth® low energy Protocol Stack RenesasBLE ~ R01AN3015
(for Android) Application

Bluetooth® low energy Protocol Stack RenesasBLE ~ R01AN3016
(for iOS) Application

The following rBLE script files are included in the downloadable file of sample scripts. To use the files with this tool,
import them to an e? studio project after decompressing the zip file which you have downloaded.

e RunningSpeedAndCadenceSensor.rble : RSCP (Running Speed and Cadence Profile) — Sensor Role
e CyclingSpeedAndCadenceSensor.rble  : CSCP (Cycling Speed and Cadence Profile) — Sensor Role

You can easily check the operation of the connection between your smartphone or tablet and the RL78/G1D evaluation
board by running these sample scripts. Since the RenesasBLE application is made available, you can use these sample
scripts to check its coordination with applications on smartphones.

e RenesasBLE
— For Android: https://play.google.com/store/apps/details?id=com.renesas.ble&hl=en
— For iOS: https://itunes.apple.com/us/app/renesasble/id1073878076?mt=8

Notes 1. Refer to the related documents for installation and how to run the applications with smartphones.
2. Use Bluetooth®-equipped smartphones or tablets which support v4.0 or a later version of the Bluetooth
specification.

The relations between the RL78/G1D evaluation board on which the sample script is run and the smartphone on which
RenesasBLE is run are as follows. RSCP is taken as the profile, but the roles are the same for CSCP.

Table 3-5 Relations between Devices

GAP role Profile role
RL78/G1D evaluation board Peripheral RSCP — Sensor
Smartphone Central RSCP — Collector
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Figure 3-11 Configuration of the Overall Setup (for Running the Sample Scripts)
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4. Notes on Usage

4.1 Programming the RL78/G1D evaluation board

To write a program to the RL78/G1D evaluation board, you will need an E1 emulator and V3 of the RFP (Renesas
Flash Programmer), a flash programming tool. The system configuration for programming is as follows.

RFP (Renesas Flash Programmer_) V3 \

Bluetooth® low energy
protocol stack

J

RL78/G1D evaluation board

Figure 4-1 System Configuration for Programming

There are several ways to provide power to the RL78/G1D evaluation board. The above configuration is an example of
the case where the E1 emulator provides 3.3-V power. There are other ways to provide power; e.g., providing USB
VBUS 5-V power through a separate USB cable from a PC to the RL78/G1D evaluation board.

You can change the way power is supplied by setting the slide switch on the top surface of the RL78/G1D evaluation
board. Refer to the RL78/G1D Preliminary User’s Manual: Evaluation Board (document no: R30UZ0048) for the
details.

Using this tool requires that you write the Bluetooth® low energy protocol stack for operation in a modem
configuration (referred to as “BLE software” in the remainder of this section) to the RL78/G1D evaluation board.

We have included programs for use in evaluation in the installation file for the BLE software, although you can, of
course, write your own code. Select a program file which is suitable for the purposes of your evaluation from the folder
indicated below and use the RFP for programming.

o <Install folder>\Renesas\BLE_Software_Ver X_XX\RL78_G1D\ROM_File\ccr\Modem\

For example, if you want to try a sample script file for the RSCP (Running Speed and Cadence Profile), write
RL78_G1D_CCM(LNP,RSCP).hex, which is stored in the above folder as a built program for evaluation, to the
RL78/G1D evaluation board. Refer to the Bluetooth® low energy Protocol Stack Quick Start Guide (document no:
RO1AN2767) or the Bluetooth® low energy Protocol Stack User’s Manual (document no: RO1IUWO0095) for details.
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4.2 Non-supported rBLE commands and events

The following are rBLE commands and rBLE events that QE for BLE V1.0.0 does not support under certain conditions.

e When using Bluetooth® low energy protocol stack VV1.10 or a later version prior to V1.20:

— rBLE commands
e RBLE_TIP_Server Write_Data
e RBLE_ VS Flash_Access
e RBLE VS Set Params
— rBLE events
e BLE_GAP_EVENT_WR_CHAR_IND
e RBLE_GATT EVENT DISC_SVC_INCL_CMP

e When using Bluetooth® low energy protocol stack V1.20:

— rBLE commands
e RBLE_GATT_Write_Char_Request
e RBLE _GATT_ Set Data
— rBLE event
e RBLE SM LTK REQ FOR_ENC_IND

Including an RBLE_SM_LTK_REQ_FOR_ENC_IND rBLE event in an rBLE script produces a syntax error. While
including other non-supported rBLE commands or events does not produce a syntax error, the operation is not

guaranteed.
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5. Troubleshooting

51 Tool/board

5.1.1 GUI tool does not boot up

Bluetooth® low energy protocol stack GUI tool is a C++ application which is built with Microsoft Visual Studio 2012.
To run it, you need to obtain Visual C++ Redistributable for Visual Studio 2012, Update 4, and install the runtime
components.

e Download page: http://www.microsoft.com/en-us/download/details.aspx?id=30679

Note: The GUI tool is a 32-bit application. Download Visual C++ Redistributable (VSU4\vcredist_x86.exe) for 32-bit
versions (x86) even if you are using a 64-bit version of Windows.

51.2 The RL78/G1D evaluation board does not respond [1]
Open the Device Manager of Windows, and check if the connection of the RL78/G1D evaluation board with your PC is
normal.

If “USB Serial Port (COM**)” is not displayed under the node “Port (COM and LPT)” in the Device Manager, obtain
and install the device driver for the FT232RL USB-to-UART IC from the site of Future Technology Devices
International Ltd.

e Download page: http://www.ftdichip.com/Drivers/D2XX.htm

Note: Download the x86 (32-bit) or x64 (64-bit) device driver depending on your version of Windows.

51.3 The RL78/G1D evaluation board does not respond [2]
Check the setting of the slide switch on the top surface of the RL78/G1D evaluation board.

Check how power is being provided and that the setting for USB connection has been made with reference to the
RL78/G1D Preliminary User’s Manual: Evaluation Board (document no: R30UZ0048).

Note: When executing the rBLE script function of this tool, disconnect the RL78/G1D evaluation board and E1
emulator.

514 No response to an rBLE command or event [1]

Check that the Bluetooth® low energy protocol stack GUI tool is active if the response to an rBLE command or event is
not as expected even though the rBLE script runs without problems.

Activate V1.10 or a later version of the GUI tool (rBLE_Tool.exe) if it is not active.

Check the version of the GUI tool if it is active. If the version number is 1.09 or lower, download the latest version from
the below URL.

e Download page: https://www.renesas.com/solutions/bluetooth

5.1.5 No response to an rBLE command or event [2]

Check that the program written to the RL78/G1D evaluation board is the Bluetooth® low energy protocol stack (BLE
software), which has a modem configuration, and matches the profile used in the rBLE script (communications protocol
as defined for Bluetooth®) in cases of response to an rBLE command or event not being as expected even though the
rBLE script runs.
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We have programs for evaluation which have been included in the data for the BLE installation. Select a program file
which is suitable for the purposes of your evaluation from the below folder, and use V3 of the RFP (Renesas Flash
Programmer) flash programming tool to write it to the board.

e <|nstall folder>\Renesas\BLE_Software_Ver X XX\RL78_ G1D\ROM_ File\ccr\Modem\

5.2 rBLE scripts

521 File not created
If you are unable to create new rBLE script files, check if the tool is installed in the e? studio in the following way.

1. Select [Installation Details] from the [Help] menu in the main menu bar at the top of the e? studio, then open the [e2
studio Installation Details] dialog box.

2. Check if the item [Renesas QE for Bluetooth Smart] is displayed on the [Installed Software] tabbed page of the [e2
studio Installation Details] dialog box.

e2 studio Installation Details O X
Installed Software  |nstallation History Features Plug-ins Configuration Renesas Device Support
Marme Version Id
it e2 studio 5.2.0.020 com.renesas.ide.edstudio
L+ Renesas CCRL Toolchain Integration 52.0.201609141541  com.renesas.cdt.rl78.managed
r {§t Renesas Optimization Assistant 5.2.0.201608010846  com.renesas.cdt.analysis.featu
{f+ Renesas QF common 1.0.0.201602011351  com.renesas.apltool.commaon,
li* Renesas OF for Bluetooth Smart 1.0.0.201602231158  com.renesas.apltool.blefeatun
_l/ {§ Renesas RL78 Debug Support 5.2.0.201609141541  com.renesas.cdt.rl78.debug.fe:
L+ Renesas Smart Help 52.0.201609091130  com.renesas.cdt.smarthelp.fea
[+ Renesas Stack Analysis 52.0.201607071507  com.renesas.cdt.stackanalysis.
< >
':?:' Update... Uninstall... Properties

Figure 5-1 [e2 studio Installation Details] Dialog Box

R20AN0429EJ0100 Rev.1.00 Page 31 of 35
Jan 20, 2017 RENESAS




QE for BLE: A Dedicated Tool for Bluetooth® low energy Usage Guide

If [Renesas QE for Bluetooth Smart] does not appear in the [e2 studio Installation Details] dialog box, obtain QE for
BLE from the URL below and install it.

e Download page: https://www.renesas.com/ge-ble

5.2.2 Files cannot be opened [1]

If you are unable to open an rBLE script file in the rBLE script editor, check whether the tool is installed in the e?
studio.

Obtain QE for BLE from the URL below and install it, if [Renesas QE for Bluetooth Smart] does not appear in the [e2
studio Installation Details] dialog box.

o Download page: https://www.renesas.com/ge-ble

5.2.3 Files cannot be opened [2]

If you get the following error message when trying to open an rBLE script file, follow the instructions below the
screenshot.

C/C++ - test/testl.rble - e2 studio - O X

File Edit Source Refactor MNavigate Search Project Renesas Views Run  Window Help

i R RA S ARFER S At SE o R AR SLRACASE R A Rat el s 2 8 e
P
[ Project Explorer 3 =8 ¥ = = O
5E .
. K%  Plug-in "com.renesas.apltool.ble” was unable to instantiate class -
v (& test [HardwareDebug] ¥ "com.renesas.apltool.ble.editors.RBLEScriptEditor”. el )
[ Includes
2 src
custormn.bat
B CyclingSpeedAndCadenceSensor.r
|Z| test Debug.launch
|Z| test HardwareDebug.launch
BT testl.rble
[#] Problems 3% ¥ =08
0 items
Description Resource Path Location Type
£ >
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Access the following URL and obtain Visual C++ Redistributable for Visual Studio 2012, Update 4. QE for BLE uses a
library built by Microsoft Visual Studio 2012 as a part of the configuration of modules.

o Download page: http://www.microsoft.com/en-us/download/details.aspx?id=30679

Note: The library used for QE for BLE is a 32-bit DLL. Download Visual C++ Redistributable
(VSU4\vcredist_x86.exe) for 32-hit versions (x86) even if you are using a 64-bit version of Windows.

5.24 Files cannot be opened [3]

If you get the following error message when trying to open an rBLE script file, follow the instructions below the
screenshot.

C/C++ - Ch\lUsers\apph\Desktophtest2.rble - €2 studio - O *
File Edit Source Refactor Mavigate Search Project Renesas Views Run  Window Help
Tmi R S AORFERA Y St a i o R AR AR A CASE S A RIS Sh- BoE 1= RUIENER ST S SRR Sl S50
auckrcces || 5 | [GIGRR
[ Project Explorer 3 = 8 | B testZrble (QF) = O
= <f{> -
v [E test
[ Includes
2 src

custormn.bat

B CyclingSpeedAndCadenceSensorr | ERROR
|=| test Debug.launch

|Z| test HardwareDebug.launch

BT testl.rble

[# Problems &3 =8
0 items

Description Resource Path Location Type

Display the [Project Explorer] view of the e? studio, and check whether the rBLE script file to be opened is registered
with the open project.

If the file has not been registered, import the target file to the project.
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5.25 Script will not run [1]

When the [hﬁ] button on the tool bar at the top of the e? studio or the menu item [Run rBLE script (QE)] of the [Run]
menu on the main menu bar indicates that this is invalid (by being grayed out), display the [Progress] view of the ?
studio and check if an rBLE script is already running.

If a script is running, click on the [] button across from “Running an rBLE script” in the [Progress] view. The
running rBLE script will then stop.

If a script is not running, click on the rBLE script editor to bring the editor into scope.

5.2.6 Script will not run [2]

In some cases, an unknown syntax error occurs immediately after the execution of an rBLE script starts. For example,
when a syntax error occurs in the first line, even though the first line of the rBLE script file is only a comment, check
the encoding (character code) in the target file with your text editor.

The only valid character codes for the rBLE script editor are ASCII and UTF-8 without BOM. If another encoding
(including UTF-8 with BOM) has been used, save the rBLE script file again in either of the above types of coding.

53 Others

5.3.1 Not communicable with RenesasBLE

Check if the Bluetooth® function on your smartphone or tablet supports the specification of Bluetooth v4.0 or a later
version.

If it does, activate the Bluetooth® function in the settings of your smartphone or tablet.

If it does not, you cannot use RenesasBLE.
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Website and Support

Renesas Electronics Website
https://www.renesas.com/

Inquiries
https://www.renesas.com/contact/

All trademarks and registered trademarks are the property of their respective owners.
Bluetooth is a registered trademark of Bluetooth SIG, Inc.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas.
For detailed usage notes on the products covered by this document, refer to the relevant sections of the document as
well as any technical updates that have been issued for the products.

1. Handling of Unused Pins
Handle unused pins in accordance with the directions given under Handling of Unused Pins in the
manual.
— The input pins of CMOS products are generally in the high-impedance state. In operation with
an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
LSI, an associated shoot-through current flows internally, and malfunctions occur due to the
false recognition of the pin state as an input signal become possible. Unused pins should be
handled as described under Handling of Unused Pins in the manual.
2. Processing at Power-on
The state of the product is undefined at the moment when power is supplied.
— The states of internal circuits in the LSI are indeterminate and the states of register settings and
pins are undefined at the moment when power is supplied.
In a finished product where the reset signal is applied to the external reset pin, the states of
pins are not guaranteed from the moment when power is supplied until the reset process is
completed.
In a similar way, the states of pins in a product that is reset by an on-chip power-on reset
function are not guaranteed from the moment when power is supplied until the power reaches
the level at which resetting has been specified.
3. Prohibition of Access to Reserved Addresses
Access to reserved addresses is prohibited.

— The reserved addresses are provided for the possible future expansion of functions. Do not

access these addresses; the correct operation of LSI is not guaranteed if they are accessed.
4. Clock Signals

After applying a reset, only release the reset line after the operating clock signal has become

stable. When switching the clock signal during program execution, wait until the target clock signal

has stabilized.

— When the clock signal is generated with an external resonator (or from an external oscillator)
during a reset, ensure that the reset line is only released after full stabilization of the clock
signal. Moreover, when switching to a clock signal produced with an external resonator (or by
an external oscillator) while program execution is in progress, wait until the target clock signal is
stable.

5. Differences between Products

Before changing from one product to another, i.e. to a product with a different part number, confirm
that the change will not lead to problems.

— The characteristics of Microprocessing unit or Microcontroller unit products in the same group
but having a different part number may differ in terms of the internal memory capacity, layout
pattern, and other factors, which can affect the ranges of electrical characteristics, such as
characteristic values, operating margins, immunity to noise, and amount of radiated noise.
When changing to a product with a different part number, implement a system-evaluation test
for the given product.




Notice

of these circuits, software, or information.

assumes no liability whatsoever for any damages incurred by you resulting from errors in or omissions from the information included herein.

others.
third parties arising from such alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.
the product's quality grade, as indicated below.

equipment; and industrial robots etc.

incurred by you or third parties arising from the use of any Renesas Electronics product for which the product is not intended by Renesas Electronics.

use of Renesas Electronics products beyond such specified ranges.

please evaluate the safety of the final products or systems manufactured by you.

no liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

regulations and follow the procedures required by such laws and regulations.
10.

5]

products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

(Note 1) "Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-owned subsidiaries.

(Note 2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.

“High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-crime systems; and safety equipment etc.

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for

the incorporation of these circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from the use

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics does not warrant that such information is error free. Renesas Electronics

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights of third parties by or arising from the use of Renesas Electronics products or

technical information described in this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. Renesas Electronics assumes no responsibility for any losses incurred by you or
5. Renesas Electronics products are classified according to the following two quality grades: "Standard" and "High Quality". The recommended applications for each Renesas Electronics product depends on
"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic
Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems, surgical
implantations etc.), or may cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality grade of each Renesas Electronics product before using it

in a particular application. You may not use any Renesas Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable for any damages or losses

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, especially with respect to the maximum rating, operating supply voltage

range, movement power voltage range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or damages arising out of the

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have specific characteristics such as the occurrence of failure at a certain rate and
malfunctions under certain use conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to guard them against the
possibility of physical injury, and injury or damage caused by fire in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including but not limited to

redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult,

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. Please use Renesas Electronics

products in compliance with all applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive. Renesas Electronics assumes
9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or
regulations. You should not use Renesas Electronics products or technology described in this document for any purpose relating to military applications or use by the military, including but not limited to the
development of weapons of mass destruction. When exporting the Renesas Electronics products or technology described in this document, you should comply with the applicable export control laws and
It is the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or otherwise places the product with a third party, to notify such third party in advance of the

contents and conditions set forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as a result of unauthorized use of Renesas Electronics

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products, or if you have any other inquiries.
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